RX65N Group

Renesas Starter Kit+ Tutorial Manual
For CS+

RENESAS 32-Bit MCU
RX Family / RX600 Series
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm, application examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics products.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

   "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

   "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (space and undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out of the use of Renesas Electronics products for which the product is not intended by Renesas Electronics.

6. When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out of the use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of Renesas Electronics products, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as warranty for your products/system. Because the evaluation of microcomputer software alone is very difficult and not practical, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please investigate applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall not use Renesas Electronics products or technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction, such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAV’s)) for delivering such weapons, (2) any purpose relating to the development, design, manufacture, or use of conventional weapons, or (3) any other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any other party will engage in the activities described above. When exporting, selling, transferring, etc., Renesas Electronics products or technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments of the countries asserting jurisdiction over the parties or transactions.

10. Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms and conditions described in this document, including this notice, and hold Renesas Electronics harmless, if such misuse or violation results from your resale or making Renesas Electronics products available any third party.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.3.0-1 November 2016)
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

<table>
<thead>
<tr>
<th>1. Handling of Unused Pins</th>
<th>Handle unused pins in accordance with the directions given under Handling of Unused Pins in the manual.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in the manual.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2. Processing at Power-on</th>
<th>The state of the product is undefined at the moment when power is supplied.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the moment when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the moment when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the moment when power is supplied until the power reaches the level at which resetting has been specified.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3. Prohibition of Access to Reserved Addresses</th>
<th>Access to reserved addresses is prohibited.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The reserved addresses are provided for the possible future expansion of functions. Do not access these addresses; the correct operation of LSI is not guaranteed if they are accessed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4. Clock Signals</th>
<th>After applying a reset, only release the reset line after the operating clock signal has become stable. When switching the clock signal during program execution, wait until the target clock signal has stabilized.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When the clock signal is generated with an external resonator (or from an external oscillator) during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when switching to a clock signal produced with an external resonator (or by an external oscillator) while program execution is in progress, wait until the target clock signal is stable.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5. Differences between Products</th>
<th>Before changing from one product to another, i.e. to a product with a different part number, confirm that the change will not lead to problems.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The characteristics of Microprocessing unit or Microcontroller unit products in the same group but having a different part number may differ in terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.</td>
</tr>
</tbody>
</table>
Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data, loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+, even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment causes harmful interference to radio or television reception, which can be determined by turning the equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

- ensure attached cables do not lie across the equipment
- reorient the receiving antenna
- increase the distance between the equipment and the receiver
- connect the equipment into an outlet on a circuit different from that which the receiver is connected
- power down the equipment when not in use
- consult the dealer or an experienced radio/TV technician for help

NOTE: It is recommended that wherever possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the following measures be undertaken;

- The user is advised that mobile phones should not be used within 10m of the product when in use.
- The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfill the regulatory standards for an end product.
How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the CS+ IDE to develop and debug software for the RSK+ platform. It is intended for users designing sample code on the RSK+ platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in CS+, but does not intend to be a complete guide to software development on the RSK+ platform. Further details regarding operating the RX65N microcontroller may be found in the Hardware Manual and within the provided sample code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of the manual for details.

The following documents apply to the RX65N Group. Make sure to refer to the latest versions of these documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web site.

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
<th>Document Title</th>
<th>Document No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User’s Manual</td>
<td>Describes the technical details of the RSK+ hardware.</td>
<td>RSK+RX65N-2MB User’s Manual</td>
<td>R20UT3888EG</td>
</tr>
<tr>
<td>Tutorial Manual</td>
<td>Provides a guide to setting up RSK+ environment, running sample code and debugging programs.</td>
<td>RSK+RX65N-2MB Tutorial Manual</td>
<td>R20UT3889EG</td>
</tr>
<tr>
<td>Quick Start Guide</td>
<td>Provides simple instructions to setup the RSK+ and run the first sample, on a single A4 sheet.</td>
<td>RSK+RX65N-2MB Quick Start Guide</td>
<td>R20UT3890EG</td>
</tr>
<tr>
<td>Smart Configurator</td>
<td>Provides a guide to code generation and importing into the CS+ IDE.</td>
<td>RSK+RX65N-2MB Smart Configurator Tutorial Manual</td>
<td>R20UT3891EG</td>
</tr>
<tr>
<td>Schematics</td>
<td>Full detail circuit schematics of the RSK+.</td>
<td>RSK+RX65N-2MB Schematics</td>
<td>R20UT3887EG</td>
</tr>
<tr>
<td>Hardware Manual</td>
<td>Provides technical details of the RX65N microcontroller.</td>
<td>RX65N Group, RX651 Group Hardware Manual</td>
<td>R01UH0590EJ</td>
</tr>
</tbody>
</table>
2. List of Abbreviations and Acronyms

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC</td>
<td>Analog-to-Digital Converter</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>bps</td>
<td>bits per second</td>
</tr>
<tr>
<td>CMT</td>
<td>Compare Match Timer</td>
</tr>
<tr>
<td>COM</td>
<td>COMmunications port referring to PC serial port</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>DVD</td>
<td>Digital Versatile Disc</td>
</tr>
<tr>
<td>E1/E2 Lite</td>
<td>Renesas On-chip Debugging Emulator</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>IDE</td>
<td>Integrated Development Environment</td>
</tr>
<tr>
<td>IRQ</td>
<td>Interrupt Request</td>
</tr>
<tr>
<td>LCD</td>
<td>Liquid Crystal Display</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>LSB</td>
<td>Least Significant Bit</td>
</tr>
<tr>
<td>LVD</td>
<td>Low Voltage Detect</td>
</tr>
<tr>
<td>MCU</td>
<td>Microcontroller Unit</td>
</tr>
<tr>
<td>MSB</td>
<td>Most Significant Bit</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PLL</td>
<td>Phase-locked Loop</td>
</tr>
<tr>
<td>Pmod™</td>
<td>This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to <a href="http://www.digilentinc.com/digilent-pmod-interface-specification">Digilent Inc.</a></td>
</tr>
<tr>
<td>PSU</td>
<td>Power Supply Unit</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>ROM</td>
<td>Read Only Memory</td>
</tr>
<tr>
<td>RSK+</td>
<td>Renesas Starter Kit+</td>
</tr>
<tr>
<td>RTC</td>
<td>Real Time Clock</td>
</tr>
<tr>
<td>SAU</td>
<td>Serial Array Unit</td>
</tr>
<tr>
<td>SCI</td>
<td>Serial Communications Interface</td>
</tr>
<tr>
<td>SPI</td>
<td>Serial Peripheral Interface</td>
</tr>
<tr>
<td>TAU</td>
<td>Timer Array Unit</td>
</tr>
<tr>
<td>TFT</td>
<td>Thin Film Transistor</td>
</tr>
<tr>
<td>TPU</td>
<td>Timer Pulse Unit</td>
</tr>
<tr>
<td>UART</td>
<td>Universal Asynchronous Receiver/Transmitter</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>WDT</td>
<td>Watchdog Timer</td>
</tr>
</tbody>
</table>

All trademarks and registered trademarks are the property of their respective owners.
# Table of Contents

1. Overview ............................................................................................................................ 8
  1.1 Purpose ...................................................................................................................................................... 8
  1.2 Features ..................................................................................................................................................... 8

2. Introduction ........................................................................................................................ 9
  2.1 Smart Configurator Plugin.......................................................................................................................... 9

3. Tutorial Project Workspace .............................................................................................. 10
  3.1 Introduction .............................................................................................................................................. 10
  3.2 Starting CS+ ............................................................................................................................................. 10
  3.3 Configuring the Debug Tool (E2 Lite) ....................................................................................................... 14
  3.4 Build Configuration ................................................................................................................................... 15

4. Building the Tutorial Program .......................................................................................... 16
  4.1 Building the Code..................................................................................................................................... 16
  4.2 Connecting the Debugger ........................................................................................................................ 17
  4.3 Saving Project Settings ............................................................................................................................ 17

5. Downloading and Running the Tutorial ............................................................................ 18
  5.1 Downloading the Program Code.............................................................................................................. 18
  5.2 Running the Tutorial ................................................................................................................................. 18

6. Reviewing the Tutorial Program ....................................................................................... 19
  6.1 Program Initialization ............................................................................................................................... 19
  6.2 Main Functions ......................................................................................................................................... 20

7. Additional Information ...................................................................................................... 23
1. Overview

1.1 Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK+ tutorial started, and basic debugging operations.

1.2 Features

This RSK+ provides an evaluation of the following features:

- Renesas microcontroller programming
- User code debugging
- User circuitry such as switches, LEDs and a potentiometer
- Sample application
- Sample peripheral device initialization code

The RSK+ board contains all the circuitry required for microcontroller operation.
2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas Starter Kit+ (RSK+). The tutorials help explain the following:

- How do I compile, link, download and run a simple program on the RSK+?
- How do I build an embedded application?
- How do I use Renesas’ tools?

The project generator will create a tutorial project with three selectable build configurations:

- ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
- ‘Debug’ is a project built with the debugger support included. Optimisation level is set to zero.
- ‘Release’ is a project with optimised compile options (level two) and no outputs debugging information options selected, producing code suitable for release in a product.

Files referred to in this manual are installed using the project generator as you work through the tutorials. The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not match exactly with that in the actual source files. It is also possible that the source address of instructions illustrated in this manual differ from those in user code compiled from the same source. These differences are minor, and do not affect the functionality of the sample code nor the validity of this manual.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-depth information.

2.1 Smart Configurator Plugin

The Smart Configurator plug in for the RX65N has been used to generate the sample code discussed in this document. Smart Configurator for CS+ is a plugin tool for generating template ‘C’ source code and project settings for the RX65N. When using Smart Configurator, it supports the user with a visual way of configuring the target device, clocks, software components, hardware resources and interrupts for the project; Thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Smart Configurator’ function is used to generate three code modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’, ‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example ‘CMT’. Within these code modules, the user is then free to add custom code to meet their specific requirement. Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit Smart Configurator to change any MCU operating parameters.

RSK sample project, only some functions are used.
For other useful features, refer to the [https://www.renesas.com/smart-configurator](https://www.renesas.com/smart-configurator).
3. **Tutorial Project Workspace**

3.1 **Introduction**

CS+ is an integrated development tool that allows the user to write, compile, program and debug a software project on the RX, RL78 and RH850 family of Renesas microcontrollers. CS+ will have been installed during the installation of the software support for the Renesas Starter Kit+ product. This manual will describe the stages required to create and debug the supplied tutorial code.

3.2 **Starting CS+**

To use the program, start CS+:
Windows™ 7 & Vista: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View, click ‘CS+ for CC (RL78,RX, RH850)’ icon

Windows™ 10: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

The first time CS+ is started, the One Point Advice dialog box will be shown:

![One Point Advice Dialog Box](image)

The One Point Advice dialog box provides some useful tips when using CS+. Press ‘OK’ to skip the advice and close the One Point Advice dialog.
When logging in for the first time, the login screen for “My Renesas” is displayed as shown below. Please enter your email address and password and click the login button.

The user will then be presented with the Start panel.

Under the ‘Open Sample RSK Project’, open a new Tutorial project by selecting the RSK+RX65N-2MB_Tutorial project template and click on ‘Go’ as shown below. This will save a copy of the RSK+RX65N-2MB_Tutorial project.
• CS+ will present a 'Create Project' dialog box.
  • Select all sub-projects by clicking on each checkbox and observe the information displayed under the 'Subproject information' heading as you select each project.
  • Specify a name and location for the new project and click on 'Create'.
  • A dialog box will appear if the location specified does not exist; asking to create the folder specified. Click 'OK'.

• CS+ will create and open the project showing the Project Tree as seen in the screenshot opposite.
  • RSK+RX65N-2MB_Tutorial (Project) is the master project and includes the tools to modify, build and debug the code.
  • The File folder seen in the screenshot belongs to the master project, RSK+RX65N-2MB_Tutorial.
  • This folder contains and lists all project source and header files including text files arranged in separate folder structures.
  • Folders containing the subprojects, indicated by "(Subproject)" are listed below the File folder.
  • Each subproject folder, when expanded, reveals an identical tools and folder structure to that of the master project, RSK+RX65N-2MB_Tutorial.
  • By default the RSK+RX65N-2MB_Tutorial project is set as the active project, indicated by the line under the project name.

Note: 'Smart Configurator (Design Tool)' node is shown in the 'Project Tree' and indicates an optional plug-in has been enabled previously.
• To change the active project, right-click on the project/subproject name and select “Set x as Active Project” (x represents the project name).

• The opposite screen-shot is an example of changing an Application subproject to an active project.

• The File folder contains four subfolders. This structure is common to all projects.

• Some of the source files were generated by Smart Configurator, which are grouped under the ‘Smart Configurator’ folder which itself is listed under the File folder in the Project Tree. These files are prefixed with ‘Config_*’ to indicate that they were generated by a Smart Configurator. All other user-generated source files are contained in the ‘C Source Files’ folder.

• To open a file for viewing, right-click on the file and select ‘Open’. Alternatively, double-click on the file.
3.3 Configuring the Debug Tool (E2 Lite)

Note: The Tutorial sample project’s settings are pre-configured. This section is intended to familiarise the user with the debug tool settings for when they create their own project.

- The Project Tree will be displayed on the left-hand pane of CS+.
- This can also be invoked from the menu bar [View > Project Tree].

- The opposite screen-shot indicates that the selected Debug Tool is RX E2 Lite.

- Right click on RX E2 Lite (Debug Tool).
- Click on Property.
- View the Connect Settings.
- Verify that the settings match the opposite screen-shot.

The project is configured to halt code execution on the first instruction of the main function after programming the micro controller. To specify another function as an entry point:

- View the ‘Download file Settings’ tab of the RX E2 Lite’s property.
- Change the ‘specified symbol’ to another available function.
- Ensure to prefix the function name with an underscore (“_”).

Note: Do not specify an interrupt handler as the entry point.
3.4 Build Configuration

The build configurations are selected from the build tool's Property panel. The options available are ‘DefaultBuild’, ‘Debug’ and ‘Release’. ‘DefaultBuild’ and ‘Debug’ are configured for use with the debugger. ‘Release’ is configured for the final ROM programmable code.

A common difference between the two builds is the optimisation setting and the addition of debug information. With optimisation turned on, the debugger may seem to execute code in an unexpected order. To assist in debugging it is often helpful to turn optimisation off on the code being debugged.

- Right-click on CC-RX (Build Tool) from the Project Tree.
- Select ‘Property’.

- The ‘Common Options’ tab will open by default.
- Verify that the Build Mode is set to ‘Debug’.

Click on the ‘Compile Options’ tab to view compiler options.

- Ensure the ‘Outputs debug information’ entry is set to ‘Yes(-debug)’.
- Ensure the ‘Optimization’ entry is set to ‘0(-optimize=0)’.
4. Building the Tutorial Program

The tutorial project build settings have been pre-configured in the toolchain options. To view the toolchain options double-click on CC-RX(Build Tool) from the Project Tree and select the available tabs. It is important when changing settings to be aware of the current configuration before modifying the settings.

- Review the options on each of the tabs to be aware of the options available. For the purposes of the tutorial, leave all options at default.
- When complete, the Property panel can be closed by clicking [x] on the right-hand corner of the Property window.

4.1 Building the Code

There is a choice of three shortcuts available for building the project:

- Selecting the ‘Build Project’ toolbar button will build all projects listed in the project tree.
- Pressing [F7]. This is equivalent to pressing the ‘Build Project’ toolbar button.
- Selecting the ‘Rebuild Project’ toolbar button will rebuild all project files.
- Pressing [Shift] + [F7]. This is equivalent to pressing the ‘Rebuild Project’ toolbar button.
- Selecting the ‘Build & Download’ toolbar button will only build the active project and download the code to the target device after a successful build.
- Pressing [F6]. This is equivalent to pressing the ‘Build & Download’ toolbar button.

Build the project now by pressing [F7] or pressing one of the build icons as shown above. During the build each stage will be reported in the Output Window. The build will complete with an indication of any errors and warnings encountered during the build.
### 4.2 Connecting the Debugger

For this tutorial it is necessary to provide an external power supply to the board. Use the +5V center-positive PSU supplied with this RSK+ to power the board.

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to connect the E2 Lite to the host computer. The following assumes that the steps in the Quick Start Guide have been followed and the E2 Lite drivers have been installed.

- Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the socket.
- Connect the E2 Lite Debugger to a free USB port on your computer.
- Connect the E2 Lite Debugger to the target hardware ensuring that it is plugged into the connector marked 'E1/E2 Lite'.
- Connect the +5V center-positive PSU to the PWR connector on the RSK+.

### 4.3 Saving Project Settings

If you have changed any project settings this is a good time to save the project.

- Select 'File' | 'Save Project'.

If you make any changes to files in CS+ and want to preserve these changes, you can save them by:

- Select 'File' | 'Save All'.

You can also save files by clicking the 'Save' or 'Save All' buttons from the CS+ toolbar.

In addition files can be saved using the keyboard shortcut [Ctrl + S]:

<table>
<thead>
<tr>
<th><img src="image" alt="Save Project" /></th>
<th><img src="image" alt="Save All" /></th>
<th><img src="image" alt="Save" /></th>
<th><img src="image" alt="Ctrl + S" /></th>
</tr>
</thead>
</table>

If you make any changes to files in CS+ and want to preserve these changes, you can save them by:

- Select 'File' | 'Save All'.

You can also save files by clicking the 'Save' or 'Save All' buttons from the CS+ toolbar.

In addition files can be saved using the keyboard shortcut [Ctrl + S]:

<table>
<thead>
<tr>
<th><img src="image" alt="Save Project" /></th>
<th><img src="image" alt="Save All" /></th>
<th><img src="image" alt="Save" /></th>
<th><img src="image" alt="Ctrl + S" /></th>
</tr>
</thead>
</table>

If you make any changes to files in CS+ and want to preserve these changes, you can save them by:

- Select 'File' | 'Save All'.

You can also save files by clicking the 'Save' or 'Save All' buttons from the CS+ toolbar.

In addition files can be saved using the keyboard shortcut [Ctrl + S]:

<table>
<thead>
<tr>
<th><img src="image" alt="Save Project" /></th>
<th><img src="image" alt="Save All" /></th>
<th><img src="image" alt="Save" /></th>
<th><img src="image" alt="Ctrl + S" /></th>
</tr>
</thead>
</table>
5. Downloading and Running the Tutorial

5.1 Downloading the Program Code

Now that the code has been built in CS+ it needs to be downloaded to the RSK+.

- Click on the program download button. Alternatively, select Debug from the Menu bar and click on Download.
- On completion of program download, the debugger and code are ready to be executed. The program counter indicator will point to first line of code inside the ‘main’ function; this is the program’s entry point.

```c
void main(void)
{
    # Initialize the switch module */
    R_SWITCH_Init();

    # Set the call back function when SW1 or SW2 is pressed
    R_SWITCH_SelPressCallback(cb_switch_press);

    # Initialize the debug LCD */
    R_LCD_Init();

    # Displays the application name on the debug LCD */
    R_LCD_Display(0, (uint8_t *)"RSK+RX65N-2MB ");
    R_LCD_Display(1, (uint8_t *)"Tutorial ");
    R_LCD_Display(2, (uint8_t *)"Press Any Switch ");
}
```

Before proceeding, it is necessary to connect to the RSK G1CUSB0 port to a PC using a USB Type A to mini B cable. The first time this port is connected to the PC an 'Installing Device Driver Software' pop-up will appear and the device driver will be automatically installed. Open Device Manager, the virtual COM port will appear under 'Port (COM & LPT)' as 'RSK USB Serial Port (COMx)', where x is a number. Open a terminal; emulation program, such as HyperTerminal, with the settings 19200, 8, N, 1 and N on the virtual COM port.

5.2 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed. Click the ‘Go’ button or press F5 to begin the program from the current program counter position. It is recommended that you run through the program once first, and then continue to the review section. Operating instructions for the program can be found in the file ‘Description.txt’, under the ‘Text Files’ folder in the CS+ Project Tree.
6. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in CS+.

6.1 Program Initialization

Before the main program can run, the microcontroller must be configured. Due to the debugger configuration used for the Tutorial project and the rest of the sample projects, the user will not be able to step through the hardware initialization code. Please refer to Section 3.3 to change the entry point after programming the microcontroller. Specify ‘_R_Systeminit’ as the function name if viewing of hardware initialization is desired. The initialization code is executed every time the device is reset via the reset switch or from a power reboot. The user is advised not to use the ‘step’ feature of the debugger to exit the ‘_R_Systeminit’ function.

Ensuring the Tutorial program has been downloaded onto the RX65N; press the ‘CPU Reset’ button on the Debug Toolbar.

- From the Menu bar select View > Disassemble > Disassemble1. Alternatively, use the Display Disassemble button to open and view the ‘source and disassembly’.
- To make the Display Disassemble button available on the toolbar, right-click on the toolbar and select ‘View Panels’.

Revert back to the source by clicking on the file containing the function pointed to by the program counter indicator. Alternatively, right-click in the Disassemble1 window and click “Jump to Source”.

```c
78: void main(void) {
79:   R_SVITM_Init();
80:   R_SVITM_SetPressCallBack(db_switch_press);
81:   _R_Systeminit();
82:   _R_INIT();
83:   _R_SVITM_Init();
84:   _R_SVITM_SetPressCallBack(db_switch_press);
85:   _R_Systeminit();
86:   _R_INIT();
87:   _R_SVITM_Init();
```

```
Disassemble button
```
6. Main Functions

This section will look at the program code called from with the ‘main’ function, and how it works.

- Right click the ‘R_Config_SCI8_Serial_Receive’ function call and select ‘Go to Here’ to execute the program up to this line.
- The ‘R_LCD_Init’ function call enables and configures the LCD panel, and ‘R_LCD_Display’ will write “RSK+RX65N-2MB” onto the top line, “Tutorial” on the second line and “Press Any Switch” on the third.

- Set a breakpoint on the ‘R_Config_SCI8_Start’ function call by clicking on the On-Chip Breakpoint column to the left of the number column.
- Click the ‘Step In’ button to step into the ‘R_Config_SCI8_Serial_Receive’ function. Alternatively, press [F11].
- The program counter should now move into the ‘R_Config_SCI8_Serial_Receive’ function definition. This function is an API function provided by the Smart Configurator. It sets up the SCI8 interrupt handler code to receive a specified number of bytes into a receive buffer. Once the specified number of bytes has been received, the interrupt handler code calls a callback function as shown later on in this section.
- For full details on how to configure a project using Smart Configurator refer to the Smart Configurator Tutorial Manual.
- Press the button to resume program execution.
The program counter should come to a halt at the 'R_Config_SCI8_Start' function.

Step over the function by clicking the 'Step Over' button. Alternatively, press F10.

The 'R_Config_SCI8_Start' function enables the SCI interrupts. The program then proceeds to the main while(1U) loop. The code inside the loop waits for user input from either SCI reception or RSK switches, and then performs an A/D conversion.

Locate the function call to 'lcd_display_adc' inside the while loop.

Set a breakpoint on the 'lcd_display_adc' function call by clicking on the On-Chip Breakpoint column to the left of the number column.

In the Project Tree pane, locate the file 'Config_SCI8_user.c' and double-click to open the source file. Scroll down to the function 'r_Config_SCI8_callback_receiveend'.

Set a breakpoint on the line of code inside the 'r_Config_SCI8_callback_receiveend' function as shown opposite.

Continue to execute the program by pressing the button.

In the terminal; emulation window, press the 'c' button on the keyboard.

The program will halt at the breakpoint in the 'r_Config_SCI8_callback_receiveend' function as shown opposite. Remove the breakpoint by clicking on the breakpoint column.

Continue to execute the program by pressing the button.

```c
while (1U)
{
  uint8_t adc_result;
  /\* Wait for user requested A/D conversion flag to be set (0x1 or 0x2) */
  if (TRUE == g_adc_trigger) // Call the function to perform an A/D conversion */
    adc_result = get_adc();
  /\* Display the result on the LCD */
  lcd_display_adc(adc_result);
}
```

```c
static void r_Config_SCI8_callback_receiveend(void)
{
  /\* Start user code for r_Config_SCI8_callback_receiveend. Do */
  /\* Check the contents of g_rx_char */
  if (("c" == g_rx_char) || ("d" == g_rx_char))
    g_adc_trigger = TRUE;
  /\* Set up SCI8 receive buffer and callback function again */
  R_Config_SCI8_Serial_Receive(uint8_t * &g_rx_char, 1);
  /\* End user code. Do not edit comment generated here */
}
```

```c
static void r_Config_SCI8_callback_receiveend(void)
{
  /\* Start user code for r_Config_SCI8_callback_receiveend. Do r */
  /\* Check the contents of g_rx_char */
  if (("c" == g_rx_char) || ("d" == g_rx_char))
    g_adc_trigger = TRUE;
  /\* Set up SCI8 receive buffer and callback function again */
  R_Config_SCI8_Serial_Receive(uint8_t * &g_rx_char, 1);
  /\* End user code. Do not edit comment generated here */
}
```
6. Reviewing the Tutorial Program

• The program will halt at the breakpoint in the main while loop.
• Remove the breakpoint by clicking on the breakpoint column.
• Continue to execute the program by pressing the button.

```c
while (1)
{
    uint16_t adc_result;
    // Wait for user requested A/D conversion flag to be set (SM1 or SM2) */
    if (TMR2 == s_adc_trigger)
    {
        // Call the Function to perform an A/D conversion */
        adc_result = adc_();
        // Display the result on the LCD */
        led_display_adc(adc_result());
    }
```

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the RSK+. Adjust the potentiometer and press any switch on the RSK+ and an additional A/D conversion will be performed.

• Press the ‘Stop’ button to halt program execution.
• This is the extent of the tutorial code.

For further details regarding hardware configuration, please refer to the RX Family Software Manual and the RX65N Group, RX651 Group Hardware Manual.

The E2 emulator Lite features advanced logic-based event point trigger system, and full instruction on its use is outside the scope of this tutorial. For further details, please refer to the E2 Emulator Lite User’s Manual.
7. Additional Information

Technical Support
For details on how to use CS+, refer to the help file by opening CS+, then selecting Help > Help Contents from the menu bar.

Parts of the sample code provided with the RSK+RX65N-2MB can be reproduced using the Smart Configurator plug in tool. Source files and functions generated by Smart Configurator are prefixed with ‘r_’ and ‘R_’ or ‘Config_’, respectively.

For information about the RX65N Group microcontrollers refer to the RX65N Group, RX651 Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at: https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective companies or organisations.

Copyright
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of this document, either in whole or part is prohibited without the written permission of Renesas Electronics Europe Limited.

© 2017 Renesas Electronics Europe Limited. All rights reserved.
© 2017 Renesas Electronics Corporation. All rights reserved.
© 2017 Renesas System Design Co., Ltd. All rights reserved.
<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>May 31, 2017</td>
<td>First Edition issued</td>
</tr>
</tbody>
</table>
RX65N Group